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PRCI Thermal Analysis Model 
for Hot-Tap Welding - V 4.2 

 
Users Guide - Revision 3 

 
1.0  Introduction 

 
This manual describes the use of the PRCI Thermal Analysis Model for Hot-Tap Welding - V 
4.2, which was developed by Edison Welding Institute (EWI) for PRCI.  The model is  
intended to provide welding engineers with guidance for establishing safe parameters 
for welding onto in-service pipelines (hot-tap welding). 
 
There are two primary concerns with welding onto in-service pipelines.  The first is for welder 
safety during welding, since there is a risk of the welding arc causing the pipe wall to be 
penetrated allowing the contents to escape.  The second concern is for the integrity of the 
pipeline following welding, since welds made in-service cool at an accelerated rate as the result 
of the ability of the flowing contents to remove heat from the pipe wall.  These welds, therefore, 
are likely to have hard heat-affected zones (HAZ) and a subsequent susceptibility to hydrogen 
cracking.  The model allows burnthrough risk to be controlled by limiting inside surface 
temperature and hydrogen cracking risk to be controlled by limiting weld cooling rates. 
 
The use of this model is not a substitute for procedure qualification.  The model provides 
guidance for establishing safe parameters, but provides no means for demonstrating that these 
parameters are practical under field conditions.  To demonstrate that the parameters are 
practical, a welding procedure based on these predictions should be qualified under simulated 
conditions.(1)  A brief history of cooling rate prediction methods for welds made onto in-service 
pipelines is given in Appendix A. 
 
Because of the research nature of PRCI Thermal Analysis Model for Hot-Tap Welding - V 4.2, 
the user undertakes the sole responsibility for the consequences of any use of, misuse of, or 
inability to use, any information or results obtained from the model predictions.  Neither PRCI or 
EWI is liable for any damages resulting, directly or indirectly, from the use of this product. 
 

2.0  Getting Started 
 
Running the PRCI Thermal Analysis Model for Hot-Tap Welding - V 4.2 software requires the 
following: 
 

• 200 MHz or higher processor clock speed recommended 
• Intel Pentium/Celeron or AMD K6/Athlon/Duron or compatible processor 
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•  Windows 95/98/NT/2000/XP  
• 32 MB of RAM 
•  20 MB of free disk space  
• Microsoft Excel required to plot heat input selection curves. 

 
This manual comes with one CD-ROM disk, which contains the program, and all the related  
related software.  Also included in the program is the PRCI Hot Tap - Program Manual in PDF 
format. 
 
Installing the PRCI Thermal Analysis Model for Hot-Tap Welding software:
 
o Insert the Hot Tap compact disc into the CD-ROM drive of your PC. 

 

 

o The CD will "auto start" 
o Follow the instructions on the screen for installation.  (The software installation will automatically   

install all the program files into folder C:\Program Files\PRCI Hot Tap) 
 

 After the program has been installed, you will have a folder named PRCI Hot Tap under the 
Start / Windows / Programs Menu and a shortcut named PRCI Hot Tap to initiate the PRCI Hot-Tap 
Analysis program. 

Starting the PRCI Thermal Analysis Model for Hot-Tap Welding program:
·	 This is the initial screen you will see when you start the program. 

 

3.0  Menu Bar 
 
The Menu Bar is located at the top of the screen, as shown in Figure 1.  There are five options 
displayed:  File, Edit, Compute, Window, and Help. 
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Figure 1. Menu Bar 
 
The Menu Bar options can be accessed via the pointing device or keyboard.  To use the 
keyboard, press and hold the ALT key while pressing the key associated with the first letter of 
the option.  For example, ALT-F will select the File menu.  The LEFT and RIGHT ARROW keys 
on the keyboard can be used to navigate from left to right across the five options.  Pull-down 
menus are associated with each of the five options.  The pointing device and the UP and 
DOWN ARROW keys can be used to navigate these menus. 
 
3.1  File 
 
Selecting this Menu Bar option will generate a menu as shown in Figure 2.  The File menu 
options are:  New Project, Open Project, Delete Project, Duplicate Project, Import Data, 
Review Input, Print Report, Page Setup, and Exit. 
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Figure 2. File Menu 
 
3.1.1  New Project 
 
The New Project option under the File menu activates the Project Initialization panel, which 
allows a new data file to be generated.  The Project Initialization panel is shown in Figure 3.  To 
begin a new project, enter a unique Project ID (file name) - from 1 to 15 alphanumeric 
characters - and an optional Title (description) - from 1 to 30 alphanumeric characters .  Next, 
select the geometry of interest and the type of pipe contents.  Geometry options include Sleeve 
(sleeve-fillet weld), Branch (branch-groove weld), Bead-On-Pipe (buttering pass or weld 
deposition repair), and Heat-Sink Capacity [torch-heated, 2-in. (50-mm) -diameter area].  Pipe 
Contents options includes Gas or Liquid. 
 
After entering this information, clicking on the OK push button will lead the user to the first of 
three data input screens, which are described in Section 4. 
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Figure 3. Project Initialization Panel 
 
3.1.2  Open Project 
 
The Open Project option under the File menu activates a file selection panel, from which an 
existing data file can be selected.  This selection panel is shown in Figure 4.  Select a file from 
the list of existing files; double clicking on the file name, or clicking on the OK push button will 
open the file.  Changes can then be made to any of the fields in the three data input screens, 
which are described in Section 4. 
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Figure 4. Open Project File Selection Panel 
 
3.1.3  Delete Project 
 
The Delete Project option under the File menu activates a file selection panel that allows a 
previously entered data set to be deleted.  Select a file from the list of existing files; double 
clicking on the file name, or clicking on the OK push button will delete the file. 
 
3.1.4  Duplicate Project 
 
The Duplicate Project option under the File menu activates a file selection panel that allows a 
previously-entered data set to be duplicated under a different file name.  The pointing device 
can be used to select a file from the list of existing files; clicking on a file name will cause it to be 
highlighted.  To duplicate a project, enter a unique Project ID (file name), and an optional Title 
(description).  Clicking on the OK push button will duplicate the file. 
 
The duplicate file can then be opened as described in Section 3.1.2.  Changes can then be 
made to any of the fields in the three data input screens, which are described in Sections 4  
and 5. 
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3.1.5  Import Data 
 
The Import Data option under the File menu is inactive at this time, but will be included in a 
future release of the software.  This option will allow data sets from previous versions of the 
model to be imported into the current version. 
 
3.1.6  Review Input 
 
The Review Input option under the File menu activates a file selection panel that allows the user 
to review the input data for previously-entered data sets in tabular form.  The Review Input 
options are:  Preview, Print, Output in Rich Text Format, or Exit. 
 
3.1.7  Print Report 
 
The Print Report option under the File menu activates a file selection panel that allows the user 
to review input data and results for previously-entered data sets in tabular form.  The Print 
Report options are:  Preview, Print, Output in Rich Text Format, or Exit. 
 
3.1.8  Page Setup 
 
The Page Setup option under the File menu activates the Windows “Page Setup” dialog, 
which allows the user to set page margins, page orientation, select a printer, etc. 
 
3.1.9  Exit 
 
The Exit option under the File menu terminates PRCI Thermal Analysis Model for Hot-Tap 
Welding - V 4.2, saves all data files, and exits to the operating system. 
 
3.2  Edit 
 
This Menu Bar menu option is intended for use only when the Weld Conditions panel is 
displayed.  Selecting this option will generate a pull-down menu as shown in Figure 5.  The Edit 
menu options are:  Duplicate Weld Condition and Delete Weld Condition.  A further 
description of these options is given under the description of Weld Conditions panel in Section 
4.2. 
 

 
7 



 
 
Figure 5. Edit Menu 
 
3.3  Compute 
 
Selecting this Menu Bar option will generate a pull-down menu as shown in Figure 6.  The 
Compute menu options are:  Analyze and Graph Results.  Selecting the Analyze option 
activates a file selection panel that allows the user to run the finite-element solver and generate 
results for the file selected, as described in Section 6.  Selecting the Graph Results option 
activates a file selection panel that allows the user to generate a heat input selection curve, as 
described in Section 7, for the file selected.  The Graph Results option is only functional after 
the solver has been run for a particular file. 
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Figure 6. Compute Menu 
 
3.4  Window 
 
Selecting this Menu Bar menu option allows the user to navigate between windows. 
 
3.5  Help 
 
At this time, the Help menu option displays a standard Windows “About” screen.  This option 
will allow the user to access help screens, and will be included in a future release of the 
software. 
 

4.0  Entering Data 
 
Selecting the New Project option under File on the Menu Bar will activate the Project 
Initialization panel, as shown in Figure 3.  After entering a Project ID (file name), and optional 
Title (description), and selecting a Geometry and Pipe Contents, clicking on the OK button will 
display the first of three data input panels:  Pipe Joint, Weld Conditions (or Heating Conditions), 
and Pipe Contents.  Each of the three data input panels contains a feature that allows the user 
to select either English or Metric units as a default.  Each of the three data input panels also 
contain a data integrity check routine.  Clicking on the push button labeled “✔ ” will check that 
the value for each parameter entered falls within pre-defined limits.  These limits are shown in 
Table 1.  If a given value falls outside these limits, an error message will be displayed.  After 
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entering data, closing any of the three data input panels will cause the data that was entered 
to be saved. 
 
Table 1. Pre-Defined Input Data Limits 
 

Parameter Limit 
Pipe outside diameter in. (m) 0-100 (0-2.54) 

Pipe thickness, in. (mm) 0.1-2 (2.5-50.8) 
Pipe temperature, °F (°C) -50-400 (-46-204) 

Ambient temperature, °F (°C) -50-200 (-46-93) 
Sleeve or branch thickness, in. (mm) 0.1-2 (2.5-50.8) 

Sleeve or branch temperature, °F (°C) -50-400 (-46-204) 
Gap between pipe and sleeve, in. (mm) 0-0.125 (0-3.2) 

Branch root gap, in. (mm) 0-0.125 (0-3.2) 
Angle between pipe and edge of branch, deg 0-45 

Branch outside diameter, in. (m) 0-100 (0-2.54), < Pipe OD 
Weld current, amps 20-200 
Arc voltage, volts 4-30 

Weld travel speed, in./min (mm/sec) 0.5-20 (0.2-8.5) 
Weld heat input, kJ/in. (kJ/mm) 10-80 (0.4-3.2)* 

Pressure, psi (kPa) gage 0-10,000 (1397) 
Velocity, ft/sec (m/sec) 0-200 (61.0) 

Gas temperature, °F (°C) -50-400 (-46-204) 
 
* Rounded to the nearest whole number in kJ/in. 
 
4.1  Pipe Joint 
 
The Pipe Joint data input panel contains fields for entering details pertaining to the pipe material 
of interest and other details depending on which geometry has been selected.  This input panel 
is shown in Figure 7 for a sleeve-fillet weld example.  Illustrations of the three weld geometries 
are shown in Figures 8-10.  Fields pertaining to the pipe material include Material, Outer 
Diameter, Thickness, Temperature, and Ambient Temperature.  For cases involving a sleeve-
fillet weld, fields pertaining to other details include Material, Thickness, Temperature, and Gap 
Between Pipe and Sleeve.  For cases involving branch-groove welds, fields pertaining to other 
details include Material, Thickness, Temperature, Branch Root Gap, Angle Between Pipe and 
edge of Branch (i.e., the branch bevel angle), and Branch Outer Diameter.  For Bead-on-Pipe or 
Heat-Sink Capacity cases, no other details are required. 
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Figure 7. Pipe Joint Data Input Panel 
 
 
 
 
 

 
 
Figure 8. Illustration of Sleeve-Fillet Weld Geometry 
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Figure 9. Illustration of Branch-Groove Weld Geometry 
 
 
 

 
 
Figure 10. Illustration of Bead-on-Pipe Weld Geometry 
 
The Pipe Joint data input panel also contains a push button labeled Max. Hardness that, when 
selected, activates a Base Metal Chemistry input panel, which is shown in Figure 11.  This input 
is only required if the user requires HAZ hardness predictions calculated using the Yurioka 
algorithm, the use of which is described in Section 7.  If base metal chemistry is entered, 
hardness predictions will appear in tabular form on the printed report after running the finite 
element solver and as part of the enhanced heat input selection curves which are also 
described in Section 7. 
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Figure 11. Base Metal Chemistry Input Panel 
 
The remaining feature on the Pipe Joint data input panel is push button links to the other two 
data input panels. 
 
4.2  Weld or Heating Conditions 
 
The second data input panel is Weld Conditions for Sleeve, Branch, and Bead-on-Pipe cases, 
or Heating Conditions for Heat-Sink Capacity cases. 
 
The Weld Conditions data input panel contains fields for entering details pertaining to the 
welding parameters.  This input panel, which allows multiple cases to be run from a single input 
file, is shown in Figure 12.  After entering an optional weld description, options for entering the 
welding parameters include Enter Weld Parameters or Enter Heat Input.  Selecting Enter Weld 
Parameters allows specific values for welding current, voltage, and travel speed to be entered.  
Selecting Enter Heat Input requires that only a value for the resulting heat input is entered - the 
software selects specific values for welding current, voltage, and travel speed according to a 
preset algorithm.  These specific values are shown as a function of heat input in Figures 13 and 
14. 
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Figure 12. Weld Conditions Data Input Panel 
 
For cases where Enter Welding Parameters is selected, the fields pertaining to the welding 
parameters include Electrode Type, Electrode Diameter, Weld Speed, Arc Voltage, and Weld 
Current.  For cases where Enter Heat input is selected, the fields pertaining to the welding 
parameters are the same except Heat Input replaces Weld Speed, Arc Voltage, and Weld 
Current. 
 
A field for entering the arc efficiency of the welding process is also provided on the Weld 
Conditions data input panel.  A pull-down menu containing arc efficiency for common welding 
processes is provided.  A user-defined value for arc efficiency can also be entered. 
 
The counter at the bottom of the Weld Conditions data input panel tells the user what case is 
currently being displayed.  To enter another case, the user can simply toggle to the next unused 
Weld Conditions data input panel, or use the Edit feature on the Menu Bar.  Selecting the Edit 
feature will generate a pull-down menu as shown in Figure 5.  The Edit menu options are:  
Duplicate Weld Condition and Delete Weld Condition.  Selecting Duplicate Weld Condition 
will duplicate the weld condition that is currently displayed.  Changes can then be made to the 
duplicated weld condition.  Selecting Delete Weld Condition deletes the weld condition that is 
currently displayed. 
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Figure 13. Welding Current Used when Enter Heat Input Option is Specified 
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Figure 14. Travel Speed Used when Enter Heat Input Option is Specified 
 
The Heating Conditions data input panel for Heat-Sink Capacity cases is shown in Figure 15.  
This panel is similar to the Weld Conditions data input panel except that it contains fields for 
entering data pertaining to torch heating conditions.  The Enter Heating Parameters option is 
inactive at this time.  The ability to run cases using the Enter Heating Parameters option will be 
included in a future release of the software.  To obtain heat-sink capacity predictions that are 
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consistent with the procedure used in previous programs at EWI,(6) a Heating Rate value of 
3.272 BTU/sec should be used.  The EWI heat-sink capacity measurement procedure is given 
in Appendix B. 
 

 
 
Figure 15. Heating Conditions Data Input Panel 
 
4.3  Pipe Contents 
 
The Pipe Contents data input panel contains fields for entering details pertaining to the pipe 
contents.  This input panel is shown in Figure 16 for a gas pipeline contents example.  Options 
for entering the flow rate include Linear Flow Rate or Volumetric Flow Rate.  Fields pertaining to 
the Pipe Contents include Gas (or Liquid) Type, Linear (or Volumetric) Flow Rate, Temperature, 
and Pressure.  For cases involving gas pipeline contents, a pull-down menu containing a list of 
common gases is provided.  For cases involving liquid pipeline contents, a pull-down menu 
containing a list of common liquids is provided. 
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Figure 16. Pipe Contents Data Input Panel 
 

5.0  Modifying Previously-Entered Data 
 
Previously entered data sets can be modified either by simply opening the data file and making 
changes, whereby the previous version of data file will be lost, or by using the Duplicate Project 
feature under the File option on the Menu Bar, which allows a previously-entered data set to be 
duplicated under a different file name.  Selecting the Duplicate Project feature will activate the 
Duplicate Project panel, as shown in Figure 17.  The pointing device can be used to select a file 
from the list of existing files; clicking on a file name will cause it to be highlighted.  To duplicate a  
project, enter a unique Project ID (file name), and an optional Title (description).  Clicking on the 
OK push button will duplicate the file. 
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Figure 17. Duplicate Project Panel 
 
This feature allows the user to begin with parameters from a previously entered data set and is 
particularly useful for cases that involve the same welding conditions but different flow 
parameters, for example.  After the file is duplicated, the new file can be opened, as described 
above, and changes can then be made to any of the fields in the three data input screens, 
without loosing the data set that was duplicated. 
 

6.0  Running the Program 
 
After a data set has been entered, closing any of the three data input panels will cause the data 
that was entered to be saved.  To run the finite-element solver, select the Analyze option from 
the pull-down menu under Compute on the Menu Bar, which will activate the Start Analysis file 
selection panel as shown in Figure 18.  Select a file from the list of existing files; double clicking 
on the file name, or clicking on the OK push button will run the finite element solver and 
generate results for the file selected.  While the program is running, a DOS screen will appear, 
as shown in Figure 19, on which the progress of the program can be monitored.  Once the 
program has completed running the selected file, the results can be viewed in tabular form by 
clicking on the OK button.  Note:  clicking on the OK button before the program has completed 
running the selected file will result in an error. 
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Figure 18. Start Analysis File Selection Panel 
 

 
 
Figure 19. DOS Screen for Finite-Element Solver 
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7.0  Using the Results 
 
7.1  Controlling Burnthrough Risk 
 
The inside surface temperature predictions are used to control the risk of burnthrough.  Safe 
parameters are defined as those which produce an inside surface temperature of less than 
1800°F (982°C) when using low-hydrogen electrodes or [less than 1400°F (760°C) when using 
cellulosic-coated electrodes].  In a series of previously conducted experiments,(2) Battelle 
observed that burnthrough tended to occur when the inside surface temperature exceeded 
2300°F (1260°C).  The 500°F (278°C) temperature difference between this and the 1800°F 
(982°C) limit was introduced as a margin for safety.  For individual cases that result in an inside 
surface temperature greater than the limits established by Battelle, an asterisk is provided 
adjacent to the inside surface temperature prediction on the printed report. 
 
7.2  Controlling Hydrogen Cracking Risk 
 
The weld cooling rate and cooling time between 800 and 500°C (∆t8-5) predictions are used to 
control the risk of hydrogen cracking.  Hydrogen cracking susceptibility tends to increase with 
increasing hardness and hardness tends to increase with faster weld cooling rates (or shorter 
∆t8-5 times).  There are two ways to use the results to control the risk of hydrogen cracking:  the 
chemical composition method and the carbon equivalent method.  The use of the latter is less 
precise but requires fewer details of the pipe material chemical composition. 
 
7.2.1  Chemical Composition Method 
 
Knowing the predicted ∆t8-5 time and the chemical composition of the pipe material, a previously 
developed algorithm, such as the one built into the software that was developed by Yurioka,(3) 
can be used to predict the HAZ hardness.  The hardness level above which hydrogen cracking 
can be expected to occur, or the critical hardness level, depends on the carbon equivalent level 
of the materials and on the hydrogen level of the welding process.  The critical hardness level 
for in-service welds is shown as a function of carbon equivalent level and weld hydrogen level in 
Figure 20.  This criteria, which is a modification of previous work by Matharu and Hart,(4) was 
developed for welds made under simulated in-service conditions during earlier work at EWI.(5) 
 
If base metal chemical composition is entered using the push button labeled Max. Hardness on 
the Pipe Joint data input panel, hardness predictions will appear in tabular form on the printed 
report after running the finite-element solver.  The solver predicts HAZ hardness using the 
Yurioka algorithm and the predicted ∆t8-5 time.  To evaluate the risk of hydrogen cracking, the 
user can compare the predicted hardness to those shown in Figure 20.  Alternatively, an 
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enhanced heat input selection curve can be plotted from which the required heat input can be 
determined. 
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Figure 20. Critical Hardness for In-Service Welds vs. Carbon Equivalent and Weld 

Hydrogen Level 
 
To plot an enhanced heat input selection curve, select the Graph Results option from the pull-
down menu under Compute on the Menu Bar, which will activate the Chart Data file selection 
panel as shown in Figure 21.  Select a file from the list of existing files; double clicking on the file 
name, or clicking on the OK push button will export the results to a MS Excel spreadsheet and 
automatically graph the results.  Note:  after MS Excel launches, Enable Macros must be 
selected. 
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Figure 21. Graph Results File Selection Panel 
 
An example of an enhanced heat input selection curve is shown in Figure 22.  The required heat 
input is determined by selecting the critical hardness for the carbon equivalent level and weld 
hydrogen level of interest from Figure 20, selecting the corresponding ∆t8-5 time from the 
Yurioka predictions from the bottom part of the graph, and then using the heat input selection 
curve in the top part of the graph to determine the required heat input level. 
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Figure 22. Example of Enhanced Heat Input Selection Curve 
 
7.2.2  Carbon Equivalent Method 
 
Limits on weld cooling rates and ∆t8-5 times used in previous work by Battelle(6) are shown in 
Table 2 for materials with different carbon equivalent levels.  These limits, which are a 
modification of previous work by Graville and Read,(7) are intended to avoid a HAZ hardness 
greater than 350 HV.  According to this criteria, safe parameters are defined as those that 
produce weld cooling rates less than those shown in Table 2 (or ∆t8-5 times greater than those 
shown in Table 2).  To evaluate the risk of hydrogen cracking, the user can compare the 
predicted weld cooling rates and ∆t8-5 times to those shown in Table 2.  Alternatively, a standard 
heat input selection curve can be plotted from which the required heat input can be determined. 
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To plot a standard heat input selection curve, select the Graph Results option from the pull-
down menu under Compute on the Menu Bar, which will activate the Chart Data file selection 
panel as shown in Figure 21.  Select a file from the list of existing files; double clicking on the file 
name, or clicking on the OK push button will export the results to a MS Excel spreadsheet and 
automatically graph the results.  Note:  after MS Excel launches, Enable Macros must be 
selected. 
 
Table 2. Limits on Weld Cooling Rates and ∆t8-5 Times vs. Carbon Equivalent 
 

Cooling parameter  Carbon Equivalent, 
CEIIW Cooling rate at 1000°F 

(538°C), deg F/sec, 
above which 350 HV is expected 

800 to 500°C (1473 to 932°F) 
weld cooling time (∆t8-5), sec, 

below which 350 HV is expected 
0.50 31 13 
0.45 43 9 
0.40 56 7 
0.35 74 5 
0.30 94 3 
0.25 120 2 

 
An example of a standard heat input selection curve is shown in Figure 23.  The required heat 
input is determined by selecting the corresponding ∆t8-5 time for the material of interest from 
Table 2 and then using the heat input selection curve to determine the required heat input level. 
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Figure 23. Example of Standard Heat Input Selection Curve 
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7.3  Heat-Sink Capacity Prediction 
 
Once the required welding parameters for the conditions of interest have been determined, the 
heat-sink capacity for those conditions can be predicted and used in the field to verify that the 
flow conditions that exist are close to those used for the predictions. 
 
7.4  Precautions/Limitations 
 
The following is a partial list of precautions and/or limitations for the use of the model: 
 

• Using the Enter Heat Input option to model a case where the actual welding current level 
will be higher than that shown in Figure 13 (e.g., higher that that used by the algorithm) 
can result in non-conservative inside surface temperature predictions. 

 
• An entered heat input value of less than 10 kJ/in. (0.4 kJ/mm), which is the minimum 

value shown in Table 1, will default to 10 kJ/in. (0.4 kJ/mm). 
 
• Discontinuous heat input selection curves will results unless step-wise increases in heat 

input are made. 
 
• If the chemical composition of the sleeve or branch material is less-favorable than that of 

the pipe material (e.g., if the carbon equivalent is higher), non-conservative predictions 
for the heat input required to avoid hydrogen cracking can result. 

 
• The only extensive validation trials that have been conducted to date are ∆t8-5 

predictions for sleeve-fillet welds with methane gas as the pipe contents.  Inside surface 
temperature predictions were validated against Battelle model predictions for sleeve-fillet 
welds with methane gas as the pipe contents.  A summary of these validation exercises 
is given in Appendix C. 

 
• The use of this model is not a substitute for procedure qualification.  The model provides 

guidance for establishing safe parameters, but provides no means for demonstrating that 
these parameters are practical under field conditions.  To demonstrate that the 
parameters are practical, a welding procedure based on these predictions should be 
qualified under simulated conditions.(1) 

 
Additional precautions and/or limitations may be added to this list in future versions of this users 
manual. 
 

8.0  Example 
 
The following examples are intended to demonstrate the use of the model.  For these examples, 
fillet welds at the ends of a full-encirclement repair sleeve are required on a 16-in. (406-mm) 
diameter by 0.250-in. (6.4-mm) -thick pipeline composed of API Grade 5L X52 line pipe.  The 
chemical composition of the pipe material is assumed to be that shown in Table 3.  The sleeve 
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material is assumed to be the same as the pipe material.  The pipeline is transporting natural 
gas (consisting mostly of methane) at 600 psi (4.14 mPa), 10 ft/sec (3.0 m/sec), and 80°F 
(27°C).  A qualified welding procedure is available for this application which uses low-hydrogen 
electrodes and covers a range of heat input levels. 
 
Table 3. Pipe Material Chemical Composition for User Example 01 
 

Composition, wt % Element 
N5 

C 0.21 
Mn 1.20 
P 0.011 
S 0.009 
Si 0.20 
Cu 0.010 
Ni 0.020 
Cr 0.030 
Mo 0.010 
Al 0.054 
V 0.000 

Nb 0.000 
N 0.000 
B 0.000 

CEIIW 0.42 
 
8.1  Chemical Composition Method Example 
 
For this chemical composition method example, assume that details of the pipe material 
chemical composition are known or can be determined. 
 
Begin by selecting New Project from the File pull down menu on the Menu Bar.  Type a file 
name in the Project ID field, “userex01” for this example, and an optional description in the Title 
field, “User Example 01” for this example.  Select Sleeve for the Geometry option and Gas for 
the Pipe Contents option.  Click on the OK push button. 
 
In the Pipe Joint data input panel, enter the parameters of interest, including the pipe material 
chemical composition shown in Table 3 by activating the push button labeled Max. Hardness.  
Closing the input panels by clicking on the OK push button will cause the data that was entered 
to be saved.  When the required parameters on the Pipe Joint data input panel have been 
entered, click on the push button labeled “✔ ” to check that the value for each parameter entered 
falls within pre-defined limits.  Click on the push button labeled Weld Conditions to proceed to 
the next data input panel. 
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In the Weld Conditions data input panel, enter the welding parameters for the cases of interest.  
For this example, assume that qualified welding procedure covers heat input levels ranging from 
15 to 40 kJ/in. (0.6 to 1.6 kJ/mm), and that the welding parameters of interest include heat input 
levels of 15, 25, and 40 kJ/in.  Begin by entering the welding parameters for a heat input of 15 
kJ/in.  Type a description of the weld in the Weld Description field, “Low HI” for this case.  For 
this example, select Enter Heat Input as the Weld Options option.  In the Welding Parameter 
section, enter the required parameters for a heat input of 15 kJ/in.  For the second heat input 
levels in this example, select Duplicate Weld Condition from the Edit pull-down menu on the 
Menu Bar.  Repeat this procedure for the third heat input level.  Use the counter at the bottom of 
the panel to select the second case and change the description of the weld in the Weld 
Description field to “Medium HI” and the heat input to 25 kJ/in. in the Welding Parameter 
section.  Repeat this process for the third case by changing the description of the weld to “High 
HI” and the heat input to 40 kJ/in.  As an alternative to this duplicate-and-change procedure, the 
parameters for each individual case could have been entered individually.  Click on the push 
button labeled “✔ ” for each case to check that the value for each parameter entered falls within 
pre-defined limits.  Click on the push button labeled Pipe Contents to proceed to the next data 
input panel. 
 
In the Pipe Contents data input panel, enter the parameters of interest.  When the required 
parameters have been entered, click on the push button labeled “✔ ” to check that the value for 
each parameter entered falls within pre-defined limits.  Closing any of the data input panels by 
clicking on the “ ” in the upper right-hand corner will cause the data that was entered to be 
saved. 
 
To run the example, select the Analyze option from the pull-down menu under Compute on the 
Menu Bar.  Select the file name userex01 from the list of existing files and click on the OK push 
button.  A DOS screen will appear while the program is running, after which the results can be 
viewed in tabular form by clicking on the push button labeled OK.  To evaluate the risk of 
burnthrough, the predicted inside surface temperatures can be compared to the limits described 
in Section 7.1.  To evaluate the risk of hydrogen cracking, the resulting HAZ hardness can be 
compared to the critical hardness level shown in Figure 19, or an enhanced heat input selection 
curve can be plotted from which the required heat input can be determined. 
 
To plot an enhanced heat input selection curve, select the Graph Results option from the pull-
down menu under Compute on the Menu Bar.  Select the file name userex01 from the list of 
existing files and click on the OK push button.  The results will be exported to a MS Excel 
spreadsheet and graphed automatically.  The resulting enhanced heat input selection curve for 
this example is shown in Figure 24.  To determine the required heat input level, the critical 
hardness level for this material and a weld hydrogen level of < 4 ml/100 gm of deposited weld 
metal (properly treated low-hydrogen electrodes) is determined from Figure 19, which in this 
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example is 400 HV.  A corresponding ∆t8-5 time is then determined from the Yurioka predictions 
for this material by constructing a horizontal line through this hardness level in the bottom part of 
the graph (4 sec).  A vertical line is then constructed through the intersection of this line and the 
Yurioka prediction.  A second horizontal line is then constructed through the intersection of this 
line and the heat input selection curve in the top part of the graph indicating the required heat 
input level (22 kJ/in.). 
 
If the burnthrough risk for the required heat input is in question, another run of the model for this 
specific heat input level can be made to check burnthrough risk.  Another run of the model can 
also be made for the flow conditions of interest to determine the predicted heat-sink capacity.  
The predicted heat-sink capacity can be used in the field to verify that the flow conditions that 
exist are close to those used for the predictions. 
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Figure 24. Enhanced Heat Input Selection Curve for User Example 01 
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8.2  Carbon Equivalent Method Example 
 
For this carbon equivalent method example, assume that only the carbon equivalent of the pipe 
material is known or can be estimated, 0.42 CEIIW in this case, and that details of the pipe 
material chemical composition are not known. 
 
Data is entered exactly the same as it is for the Chemical Composition Method example except 
that, since details of the pipe material chemical composition are not known, there is no need to 
activate the push button labeled Max. Hardness on the Pipe Joint data input panel. 
 
Running the model is also exactly the same as it is for the Chemical Composition Method 
example except that hardness predictions will not appear on the printed report.  As with the 
Chemical Composition Method example, to evaluate the risk of burnthrough, the predicted 
inside surface temperatures can be compared to the limits described in Section 7.1.  To 
evaluate the risk of hydrogen cracking, the predicted weld cooling rates and ∆t8-5 times can be 
compared to those shown in Table 2, or a standard heat input selection curve can be plotted 
from which the required heat input can be determined. 
 
Plotting the results are also exactly the same as it is for the Chemical Composition Method 
example except that Yurioka predictions will not appear in the heat input selection curve.  The 
resulting standard heat input selection curve for this example is shown in Figure 25.  To 
determine the required heat input level, the ∆t8-5 time corresponding to the material of interest is 
determined from Table 2 (8 sec).  A vertical line is then constructed through this ∆t8-5 time.  A 
horizontal line is then constructed through the intersection of this line and the heat input 
selection curve indicating the required heat input level (36 kJ/in.).  As with the Chemical 
Composition Method example, if the burnthrough risk for this heat input is in question, another 
run of the model for this specific heat input level can be made. 
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User Example 01

Figure 25. Standard Heat Input Selection Curve for User Example 01 
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The difference between the required heat input predicted by the chemical composition method 
(22 kJ/in.) and the carbon equivalent method (36 kJ/in.) results from the chemical composition 
method allowing higher hardness than the carbon equivalent method (400 vs. 350 HV) and the 
Yurioka algorithm being less conservative than Graville and Read criteria. 
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Appendix A 
 
 

History of Cooling Rate Prediction Methods 
for Welds Made onto In-Service Pipelines 

 



History of Cooling Rate Prediction Methods 
for Welds Made onto In-Service Pipelines 

 
A1.0  Existing Battelle Model 

 
A major advancement in in-service welding technology was the development of a thermal 
analysis model for predicting burnthrough and hydrogen cracking risk for welds made onto in-
service pipelines.(A-1)  The model, which was developed by Battelle beginning in the late 1970s, 
uses two-dimensional numerical solutions of heat-transfer equations to predict inside surface 
temperatures and cooling rates for single-pass fillet welds at the end of a sleeve or a branch-to-
carrier pipe groove weld.  The model allows burnthrough risk to be controlled by limiting inside 
surface temperature and hydrogen cracking risk to be controlled by limiting weld cooling rates. 
 
The original Battelle model was developed for main-frame computers and was implemented by 
only a handful of companies.  Delivery of the original Battelle model was either by reel-to-reel 
magnetic tape or three boxes of computer cards.  To simplify the use of the original model, 
Columbia Gas developed a compendium of results in the form of tables and graphs.(A-2)  
Beginning in 1989, Battelle and EWI worked together to further develop the Battelle model.(A-3)  
This further development included refinement, further validation, and adapting the model so that 
it could be used on a personal computer (PC). 
 
Some significant results were generated from this early work at Battelle.  Regarding the risk of 
burnthrough, use of the Battelle model was able to show that burnthrough is unlikely if the wall 
thickness is 0.250 in. (6.4 mm) or greater, provided that low-hydrogen electrodes and normal 
welding practices are used,(A-4) and that the effect of pressure on burnthrough risk is secondary, 
since the size of the heated area is small.  Regarding the risk of hydrogen cracking, the Battelle 
model allowed welding parameters (i.e., required heat input levels) to be chosen based on 
anticipated weld cooling rates.  Experiments by Battelle were also able to draw attention to the 
fact that the use of low-hydrogen electrodes significantly reduces hydrogen cracking risk.  Prior 
to this, it was common for cellulosic-coated electrodes to be used for in-service welding, and a 
number of significant incidents occurred as a result.(A-5-A-6) 

 
2.0  Heat-Sink Capacity Method 

 
A second method for predicting required heat input levels was developed concurrently at EWI(A-

7) and involves measuring the ability of the flowing contents to remove heat from the pipe wall 
using a simple field test (Figure A1).  This test involves quickly heating a 2-in. (50-mm) -
diameter area on the pipeline with an oxy-fuel torch to between 300 and 325°C.  The time 
required for the area to cool from 250 to 100°C is then measured using a digital contact 
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thermometer and a stopwatch.  Six heat-sink capacity measurement trials are made and the 
average calculated.  The average value is referred to as the heat-sink capacity of the pipeline.  
The heat-sink capacity value is used to predict the weld cooling rates using empirical 
relationships that were developed from data generated in the field and in the laboratory for a 
wide range of conditions. 
 

 

 
 
Figure A1. Heat-Sink Capacity Measurement 
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With both of these methods, the predicted weld cooling rate is reported as a function of heat 
input for a given set of pipeline operating conditions (Figure A2).  Limits on the weld cooling 
rates are established based on the maximum tolerable HAZ hardness predicted using 
previously-established empirical correlations(A-8) and the anticipated carbon equivalent of the 
pipe material.  Both of these methods allow welding parameters (i.e., heat input levels) to be 
selected based on anticipated weld cooling rates. 
 

 
 
Figure A2. Example of Battelle Model-Produced Heat Input Selection Curve 
 

A3.0  Shortcomings of Existing Methods 
 
The Battelle model, while having served the industry well, has a number of shortcomings.  First, 
the finite-element meshes that are used by the model have a fixed number of elements, so 
when the thickness of the materials of interest increases, the mesh becomes unacceptably 
coarse.  This effect begins to occur at thicknesses of about 0.5 in. (12.7 mm) or so.  Since 
burnthrough risk is negligible for pipe wall thickness of 0.25 in. (6.4 mm) and greater, this does 
not affect the burnthrough risk prediction capabilities of the model.  In terms of weld cooling 
rates, however, an unacceptably coarse finite-element mesh produces results that are very 
conservative with regard to hydrogen cracking risk.(A-9) 

 
The second shortcoming of the Battelle model is the way in which hydrogen cracking risk is 
predicted from weld cooling rate predictions.  For an individual run, the model uses the 
predicted weld cooling rate to identify a material carbon equivalent for which welds made under 
the conditions of interest will have a HAZ hardness less than a fixed value of 350 HV.  This may 
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be very conservative for some applications and non-conservative for others.  The third 
shortcoming of the Battelle model is that its user friendliness leaves a lot to be desired. 
 

A4.0  PRCI Thermal Analysis Model for Hot-Tap Welding 
 
The PRCI Thermal Analysis Model for Hot-Tap Welding(A-10) is Windows-based and takes 
advantage of advancements in PC hardware technology (e.g., processor speed, user 
friendliness, etc.).  The model uses a proprietary finite-element solver that was developed at 
EWI.  Mesh generation capabilities include sleeve, branch, and bead-on-pipe geometries (the 
latter for buttering layers and weld deposition repairs).  Heat-sink capacity values can also be 
predicted for comparison with field-measured values.  The user interface uses Microsoft Access 
and allows multiple cases to be run and heat input selection curves to be generated.  The model 
runs individual cases in about 20 sec on a PC with a Pentium II, 350 MHz processor. 
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Appendix B 
 
 

Heat-Sink Capacity Measurement Procedure 
 

 



Heat-Sink-Capacity Measurement Procedure 
 
Equipment Required: 
 

• Chalk or soap stone 
• Oxy-acetylene torch with "rosebud" tip 
• Digital contact thermometer 
• Stopwatch. 

 
Procedure: 
 

1. Determine the direction of fluid flow. 
 
2. Using chalk or soap stone, scribe three 2-in.-diameter circles (approximately 12-in. 

apart) on both sides of the pipe. 
 
3. Starting with the downstream circle, use the gas torch to quickly heat the entire region to 

300°C (572°F) using a circular motion.  The maximum temperature should not exceed 
325°C (617°F). 

 
4. After attaining a temperature of between 300 and 325°C (572 and 617°F), remove the 

torch and apply the contact thermometer to the center of the circle. 
 
5. While holding the thermometer in contact with the pipe, using a stopwatch, measure and 

record the time required to cool from 250 to 100°C (482 to 212°F). 
 
6. Repeat Steps 3, 4, and 5 on the next untested upstream circle on the opposite side of 

the pipe.  If the pipe is still warm from the previous measurements, wait until normal 
temperatures are restored. 

 
Once the measurements are complete, calculate an average time from the recorded readings. 
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Appendix C 
 
 

Validation Data for PRCI Thermal Analysis 
Model for Hot-Tap Welding 

 

 



Validation Data for PRCI Thermal Analysis 
Model for Hot-Tap Welding 

 
C1.0  Introduction 

 
The PRCI Thermal Analysis Model for Hot-Tap Welding was validated my comparing model 
predictions to experimental data generated during a previous PRCI-sponsored program at EWI 
and to predictions made using the existing Battelle model.(C-1)  Examples from this validation 
exercise are given in the following sections. 
 

C2.0  Validation Data 
 
C2.1  Cooling Rate Prediction Capability 
 
The cooling rate prediction capability of the PRCI model was validated using data generated 
during a previous PRCI-sponsored program at EWI.(C-2)  During this program, weld cooling rate 
data was collected over a wide range of wall thicknesses, natural gas flow rates, and welding 
heat inputs.  This data was compared to predictions made using the PRCI model and the 
existing Battelle model.  Examples of the results are shown in Figures 1 through 4.  The results 
indicate that Battelle model predictions tend to be non-conservative for thin-wall materials, 
particularly at low flow rates, and very conservative for thick-wall materials.  The PRCI model 
predictions tend to be relatively accurate, with a consistent level of conservatism across wall 
thickness range. 
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Figure C1. Example of Validation Data for PRCI and Battelle Model Cooling Rate 
Prediction Capibility for 0.188-in. (4.8-mm) -Thick Sleeve-Fillet Welds 
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Figure C2. Example of Validation Data for PRCI and Battelle Model Cooling Rate 
Prediction Capibility for 0.250-in. (6.4-mm) -Thick Sleeve-Fillet Welds 
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Figure C3. Example of Validation Data for PRCI and Battelle Model Cooling Rate 
Prediction Capibility for 0.365-in. (9.3-mm) -Thick Sleeve-Fillet Welds 
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Figure C4. Example of Validation Data for PRCI and Battelle Model Cooling Rate 

Prediction Capibility for 0.594-in. (15.1-mm) -Thick Sleeve-Fillet Welds 
 
C2.2  Burnthrough Prediction Capability 
 
Since there is no comprehensive validation data for inside surface temperature, PRCI model 
predictions were compared to predictions made using the existing Battelle model for the 
conditions described above.  Examples of the results are shown in Figures C5 through C8.  The 
results indicate that, provided that the user enters a value for heat input only (i.e., allows the 
software select specific values for welding current, voltage, and travel speed according to the 
preset algorithm), the PRCI model predictions are nearly the same as Battelle model 
predictions.  For thin-wall materials, the PRCI model predicts slightly higher inside surface 
temperatures than the Battelle model.  If the user enters specific values for welding current, 
voltage, and travel speed, the PRCI model is be able to predict the effect of current level 
(electrode size) on burnthrough risk that was discovered during another previous PRCI-
sponsored program at EWI.(15) 
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Figure C5. Example of Comparison Between PRCI and Battelle Model Inside Surface 
Temperature Prediction Capibility for 0.188-in. (4.8-mm) -Thick Sleeve-Fillet 
Welds 
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Figure C6. Example of Comparison Between PRCI and Battelle Model Inside Surface 
Temperature Prediction Capibility for 0.250-in. (6.4-mm) -Thick Sleeve-Fillet 
Welds 
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Figure C7. Example of Comparison Between PRCI and Battelle Model Inside Surface 
Temperature Prediction Capibility for 0.365-in. (9.3-mm) -Thick Sleeve-Fillet 
Welds 
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Figure C8. Example of Comparison Between PRCI and Battelle Model Inside Surface 
Temperature Prediction Capibility for 0.594-in. (15.1-mm) -Thick Sleeve-
Fillet Welds 
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